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DESIGN AND PHOTOGRAPHY 

(2023 onwards) 

Duration : 3 Hours Maximum : 75 Marks 

 Part A  (10  1 = 10) 

Answer all questions. 

1. Lateral thinking is a method used to           

 (a) Solve problems in a logical and step-by-step manner 

 (b) Approach problems from an unconventional 

perspective 

 (c) Avoid problem-solving 

 (d)  Focus only on past experiences 

2. The element of design that refers to the lightness or 

darkness of an object is –––––––––– 

 (a) Texture  (b) Value 

 (c) Form   (d) Line 

3. –––––––––– is a type of artificial lighting used in 

photography. 

 (a) Ambient light 

 (b) Tungsten light 

 (c) Natural light 

 (d)  Diffused sunlight 
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4. The main characteristic of a macro lens is that ––––––––– 

 (a) It captures a wider field of view 

 (b) It allows for extreme close-ups with high detail 

 (c) It has a built-in zoom feature 

 (d) It is primarily used for sports photography 

5. The opposite of blue on the color wheel is  –––––––––– 

 (a) Green  (b) Orange 

 (c) Purple  (d)  Yellow 

6. The color scheme that includes four colors arranged in 

two complementary pairs is –––––––––– 

 (a) Monochromatic (b) Tetradic 

 (c) Analogous  (d)  Achromatic 

7. The tracking in typography adjust the –––––––––– 

 (a) Space between two letters 

 (b) Space between entire blocks of text 

 (c) Space between lines 

 (d)  Space between words 

8. –––––––––– format is best suited for web graphics with 

transparency. 

 (a) JPEG  (b) TIFF 

 (c) GIF   (d)  BMP 

9. The responsive grid layout allows –––––––––– 

 (a) It automatically adjusts to different screen sizes 

 (b) It only works on printed media 

 (c) It creates fixed layouts that don’t change 

 (d)  It eliminates the need for alignment 
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10. The first steps in the design process –––––––––– 

 (a) Selecting color schemes 

 (b) Understanding the purpose and audience 

 (c) Adding images and graphics 

 (d)  Choosing decorative fonts 

 Part B  (5  5 = 25) 

Answer all questions, choosing either (a) or (b). 

11. (a) Analyze the significance of negative space in design 

with examples.  

Or 

 (b) Mind mapping helps in generating creative ideas-

Discuss. 

12. (a) Differentiate between high-key and low-key lighting 

in photography.  

Or 

 (b) Write a short note on the role of framing in 

composition. 

13. (a) Brief on the significance of color temperature in 

photography. 

Or 

 (b) Mention the characteristics of analogous colours. 

14. (a) Define typeface anatomy and explain its key 

components. 

Or 

 (b) Compare and contrast between rasterization and 

vectorization in graphic design. 

15. (a) Explain grid alignment and its importance in 

layouts. 

Or 

 (b) Brief on the important parts of a page layout. 
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 Part C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b). 

16.  (a) How does storytelling design enhance audience 

engagement? 

Or 

 (b) Discuss the relationship between creativity and 

problem-solving in the design process. 

17. (a) Discuss the different types of camera operations and 

their functions.  

Or 

 (b) Explain the Exposure Triangle and how it controls 

light in photography. 

18. (a) Explain the psychological impact of different colors 

on human emotions and behavior. 

Or 

 (b) Discuss the structure and significance of the color 

wheel. 

19. (a) Explain the different types of graphics and their 

specific applications. 

Or 

 (b) How does image manipulation help in creating 

professional visual content? 

20. (a) Analyze the impact of different grid layouts on user 

experience. 

Or 

 (b) Describe the stages of the design process and their 

significance in layout development. 

––––––––– 
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Duration : 3 Hours Maximum : 75 Marks 

 Part A  (10  1 = 10) 

Answer all questions. 

1. CGI is a _________.       

 (a) Computer-Generated Imagery used in movies, 

animation, and VFX 

 (b) A type of computer virus used in digital security 

 (c) A manual drawing technique for creating animated 

sequences 

 (d) A programming language used for developing 

mobile applications 

2. The purpose of the Properties Bin in Nuke is _________. 

 (a) Store project files 

 (b) Adjust node parameters 

 (c) Merge multiple layers 

 (d) Create new nodes 
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3. A Single Frame Roto in rotoscoping refer to  _________. 

 (a) Individual Frame 

 (b) Motion-tracked Frames 

 (c) Grouped Frames 

 (d) Automated Frames 

4. _________ is an open spline best used for in rotoscoping. 

 (a) Shapes 

 (b) Shadows 

 (c) Background 

 (d) Hair 

5. The term _________ refers to the process of integrating 

CGI elements into live-action footage. 

 (a) Tracking 

 (b) Rotoscoping 

 (c) Compositing 

 (d) Matchmoving 

6. _________ is the process of replacing text or images on a 

screen within a scene. 

 (a) Compositing 

 (b) Tracking 

 (c) Rotoscoping 

 (d) Replacement 
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7. The keying technique that removes a specific color from 

footage to create transparency is _________. 

 (a) Luma Keying 

 (b) Chroma Keying 

 (c) Matte Keying 

 (d) Difference Keying 

8. The technique that uses a clean plate to compare and 

remove the background is _________. 

 (a) Chroma Keying 

 (b) Luma Keying 

 (c) Difference Keying 

 (d) Matte Keying 

9. The primary purpose of a clean plate in VFX is to 

_________. 

 (a) Add motion blur 

 (b) Remove unwanted elements 

 (c) Enhance saturation 

 (d) Increase contrast 

10. The purpose of Camera Projection in VFX is _________. 

 (a) To track camera movement 

 (b) To create shadows in a scene 

 (c) To animate character movements 

 (d) To project a 2D image onto 3D geometry 
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 Part B  (5  5 = 25) 

Answer all questions, choosing either (a) or (b). 

11. (a) Describe the importance of the Node Graph in 

Nuke. 

Or 

 (b) List any five essential tools in Nuke and their 

functions. 

12. (a) Mention the usage of Feathering in Roto and its 

importance in creating a seamless composite. 

Or 

 (b) Write short note on the process of green screen 

removal and its importance in VFX. 

13. (a) Write the key steps involved in 2D tracking in VFX. 

Or 

 (b) Explain the differences between one-point tracking, 

two-point tracking and four-point tracking in VFX. 

14. (a) Explain the purpose of using blue and green screens 

in VFX.  

Or 

 (b) Explicate how to use Keylight for chroma keying in 

VFX. 

15. (a) Elucidate the role of motion tracking in object 

removal and clean-up.  

Or 

 (b) Mention the key challenges in wire and object 

removal in dynamic scenes.  
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 Part C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b). 

16. (a) List and explain the key advantages of using Nuke 

for compositing in detail. 

Or 

 (b) Describe the key types of nodes used in the Node 

Graph and their specific functions in a compositing 

pipeline. 

17. (a) How does the choice of software impact the 

efficiency and quality of single-frame rotoscoping? 

Provide a comparative analysis. 

Or 

 (b) Explain the process and benefits of segmenting a 

character Roto. How does it improve motion 

tracking and realism? 

18. (a) Elucidate the steps involved in 3D camera tracking 

and mention how it differs from 2D tracking? 

Or 

 (b) Explain the role of tracking techniques in modern 

VFX and analyse how advancements in tracking 

software have improved the efficiency of post-

production workflows. 

19. (a) Explain the process of using Primatte Keyer in VFX 

in detail. 

Or 

 (b) Explain how IBK Color and IBK Gizmo work 

together for chroma keying in Nuke. 
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20. (a) Describe different types of 3D lights available in 

Nuke and how does lighting affect the realism of 3D 

compositing. 

Or 

 (b) Discuss the process of creating a photorealistic 3D 

composite in Nuke with the essential steps. 

   

——————— 
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 Part A  (10  1 = 10) 

Answer all questions. 

1. ___________ is NOT a type of videography. 

 (a) Cinematic  (b) Documentary 

 (c) Corporate  (d) Calligraphy 

2. The primary function of a camera’s aperture is 

___________ 

 (a) Adjusting the color balance 

 (b) Controlling depth of field 

 (c) Increasing resolution 

 (d) Changing frame rate 

3. The rule that helps in framing compositions effectively is 

___________ 

 (a) Rule of halves (b) Rule of perspective 

 (c) Rule of thirds (d) Rule of motion 
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4. The unit of measurement for sound frequency is 

___________ 

 (a) Decibels  (b) Hertz 

 (c) Watts  (d) Lumens 

5. ___________ is NOT a sound property. 

 (a) Frequency  (b) Amplitude 

 (c) Noise  (d) Pitch 

6. The microphone best for recording outdoor interviews is 
___________ 

 (a) Lavalier  (b) Condenser 

 (c) Shotgun  (d) Ribbon 

7. A Foley artistry focus on ___________  

 (a) Color correction 

 (b) Creating background music 

 (c) Recording dialogue 

 (d) Creating realistic sound effects 

8. The purpose of mastering in audio production is 
___________ 

 (a) Adjusting individual clips 

 (b) Synchronizing video and audio 

 (c) Finalizing sound quality 

 (d) Adding music 

9. The main goal of color grading in video editing is 
___________  

 (a) Increase sharpness 

 (b) Enhance storytelling through colors 

 (c) Reduce motion blur 

 (d) Adjust frame rates 
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10. ___________ is a standard video file format. 

 (a) MP3   (b) WAV 

 (c) AVI (d) PNG  

 Part B  (5  5 = 25) 

Answer all questions choosing either (a) or (b).  

11. (a) Write a short note on the importance of videography 

in corporate settings. 

Or 

 (b) Brief on the exposure triangle and its application. 

12. (a) Mention the role of lighting in setting a scene’s 

atmosphere. 

Or 

 (b) Explain the rule of third and its importance in 

framing compositions. 

13. (a) Discuss the role of acoustics in sound recording. 

Or 

 (b) Describe the properties of sound and their 

significance in recording. 

14. (a) Compare and contrast between condenser and 

dynamic microphones. 

Or 

 (b) Analyse the challenges faced in location sound 

recording. 

15. (a) Write a short note on the importance of Foley in 

storytelling. 

Or 

 (b) Brief on the key aspects of sound mastering in post-

production. 
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 Part C  (5  8 = 40) 

Answer all questions choosing either (a) or (b). 

16. (a) Explain the history and evolution of videography, 

highlighting its significance in modern media. 

Or 

 (b) Explain the different components of a camera and 

their functions in detail. 

17. (a) Discuss various lighting techniques and their 

impact on storytelling. 

Or 

 (b) How do leading lines and natural frames impact 

video composition? Explain with examples. 

18. (a) Elucidate human hearing perception and its 

influence on audiography. 

Or 

 (b) Explain the importance of frequency and amplitude 

in sound design. 

19. (a) Write in detail about the different types of 

microphones and their applications in media 

production. 

Or 

 (b) Explain in detail the process of audio mixing and 

editing. 

20. (a) Discuss the process of exporting audio and video 

files, mentioning common file formats. 

Or 

 (b) Explain how quality control is ensured in final audio 

and video production.  

——————— 
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 Part A  (10  1 = 10) 

Answer all questions. 

1. To quickly reset an object’s transformations to default 

values __________. 

 (a) Modify > Freeze Transformations 

 (b) Edit > Delete by Type > History 

 (c) Window > Outliner 

 (d) View > Default Workspace 

2. The Maya panel that allows you to set up lighting, 

shadows and rendering settings is __________.           

 (a) Render View 

 (b) Timeline 

 (c) Hypershade 

 (d) Attribute Editor 
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3. The shading material in Maya is commonly used for shiny 

or metallic surfaces is __________.               

 (a) Lambert 

 (b) Blinn 

 (c) Phong 

 (d) Surface Shader 

4. The file format used for texture maps in Maya is 

 (a) .mb   (b) .png 

 (c) .avi   (d) .mp3 

5. __________ type in Maya simulates sunlight and casts 

parallel rays. 

 (a) Point Light 

 (b) Area Light 

 (c) Directional Light 

 (d) Volume Light 

6. The Render engine in Maya best suited for realistic 

single-light product rendering is __________.         

 (a) Maya Software Renderer 

 (b) Arnold Renderer 

 (c) Vector Renderer 

 (d) Hardware Renderer 

7. The primary purpose of rigging in Maya is __________. 

 (a) To add textures to a model 

 (b) To create a skeleton for animation and movement 

 (c) To render high-quality images 

 (d) To apply lighting effects 
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8. __________ animation principle ensures that movements 

feel natural by having objects start slow, gain speed, then 

slow down again. 

 (a) Timing and Spacing 

 (b) Squash and Stretch 

 (c) Ease In and Ease Out 

 (d) Anticipation 

9. __________ tool in Maya allows you to manage and edit 

Render Layers. 

 (a) Outliner 

 (b) Hypershade 

 (c) Render Setup 

 (d) Graph Editor 

10. __________ software is commonly used for compositing 

Render Layers after rendering in Maya. 

 (a) ZBrush 

 (b) After Effects 

 (c) Blender 

 (d) Unreal Engine 

 Part B  (5  5 = 25) 

Answer all questions, choosing either (a) or (b). 

11. (a) Discuss the role of curve tools in motion paths and 

animation. 

Or 

 (b) Mention the key advantages of using the EP Curve 

Tool for surface modeling in Maya compared to 

polygon-based modeling techniques. 
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12. (a) Write short notes on UV unwrapping in Maya. 

Or 

 (b) Brief on the role of “Unfold” and “Optimize” tools in 

UV transformation. 

13. (a) Discuss how reflections and shadows affect indoor 

lighting realism in Maya. 

Or 

 (b) Explain the advantages of using HDRI maps in a 

studio lighting setup in Maya. 

14. (a) Brief on auto-rigging system and mention how it 

streamline the rigging process. 

Or 

 (b) Differentiate between a single-chain joint setup and 

a joint hierarchy with their applications. 

15. (a) How do render resolution and aspect ratio settings 

impact the final rendered image? Provide examples 

of their use in different production workflows. 

Or 

 (b) What is Motion Blur in rendering? Explain the 

difference between 2D Motion Blur and 3D Motion 

Blur in Maya. 
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 Part C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b). 

16.  (a) Describe the step-by-step process of using the Multi-

Cut Tool and the Extrude Tool in Maya. 

Or 

 (b) Compare and contrast the uses of “Project Curve on 

Mesh” and “Split Mesh with Projected Curve” with 

their applications. 

17. (a) Mention the common challenges faced when 

working with UV maps in Photoshop? How can the 

issues be fixed? Explain. 

Or 

 (b) Explain how Displacement Maps affect a model’s 

geometry compared to Bump and Normal Maps. 

18. (a) Exemplify how Depth Map Shadows can be 

optimized in Maya to reduce artifacts like shadow 

banding, flickering and incorrect shadow placement. 

Or 

 (b) Explain Three-Point Lighting in Maya and how 

Arnold’s advanced features enhance its realism. 

Provide examples. 

19. (a) Discuss the advantages and limitations of using 

Non-Linear Handles compared to traditional 

keyframe animation. 

Or 

 (b) Describe the process of keyframe animation for a 

bouncing ball. 
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20. (a) Compare and contrast diffuse and specular 

components in a material. How do they work 

together to create realistic shading? 

Or 

 (b) Describe the process of exporting Multi-Render 

Passes from Maya using Arnold. 

——————— 
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 Part A  (10  1 = 10) 

Answer all questions. 

1. _________ feature in Houdini allows you to organize and 
control different parts of a scene. 

 (a) Grouping attributes 

 (b) SDF Volume 

 (c) Pyrosolver    

 (d) Vellum Constraints 

2. The purpose of VEX programming in Houdini is      

 (a) To create realistic fire simulations  

 (b) To control and manipulate attributes procedurally 

 (c) To activate RBD simulations  

 (d) To render fluids 

3. The volume type used to create a smooth foggy 
appearance in Houdini is 

 (a) Pyro Burst Source   

 (b) SDF Volume 

 (c) Smoke Solver    

 (d) Fog Volume 

Sub. Code 

82944 

 



C–6100 

  

  
2 

4. The main function of the Pyrosolver in Houdini is      

 (a) To simulate rigid bodies   

 (b) To simulate smoke and fire 

 (c) To create soft body dynamics  

 (d) To control particle forces 

5. _________ force is used to control the movement of 
particles along a defined path in Houdini. 

 (a) POP Axis  (b) POP Curve Force 

 (c) Pyro Burst Source (d) Vellum Brush 

6. The purpose of setting up grains in a particle simulation 
is 

 (a) To simulate fire    

 (b) To simulate fluid motion 

 (c) To simulate granular materials like sand  

 (d) To create rigid body dynamics 

7. _________ technique is used to fracture geometry into 
pieces for destruction simulations in Houdini. 

 (a) RBD Activation (b) Boolean Fracture 

 (c) Particle Advection (d) Flip Viscosity 

8. The purpose of RBD constraints in Houdini is     

 (a) To control fluid viscosity  

 (b) To connect fractured pieces during a simulation 

 (c) To render smoke    

 (d) To create soft body simulations 

9. The FLIP tank in Houdini simulate _________. 

 (a) Fire and smoke    

 (b) Ocean surfaces and fluid bodies 

 (c) Rigid body dynamics   

 (d) Particle forces 

10. The parameter in Houdini that controls the thickness and 
flow of fluid in a FLIP simulation is _________. 

 (a) FLIP Viscosity (b) Pyro Solver 

 (c) RBD Cluster (d) Fog Volume 
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 Part B  (5  5 = 25) 

Answer all questions, choosing either (a) or (b). 

11.  (a) Explain how grouping attributes helps in managing 
complex scenes in Houdini. 

Or 

 (b) Describe the role of VEX programming in 
procedural modelling within Houdini. 

12.  (a) Discuss the process of creating and rendering smoke 
using the Pyro solver in Houdini. 

Or 

 (b) Explain how SDF volumes are used to simulate 
realistic cloud effects in Houdini. 

13.  (a) Describe the function of custom particle forces in a 
POP network and how they influence particle 
behaviour. 

Or 

 (b) Explain the significance of setting up grains in 
particle simulations and how it affects rendering. 

14.  (a) Discuss the process of fracturing geometry using 
Boolean fractures and its application in RBD 
simulations. 

Or 

 (b) Explain the use of RBD constraints to manage 
interactions between fractured pieces in a 
simulation. 

15.  (a) Describe how FLIP viscosity impacts the behaviour 
of fluids in a simulation and its visual effects. 

Or 

 (b) Explain the process of creating and rendering an 
ocean surface using FLIP fluids in Houdini. 
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 Part C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b). 

16.  (a) Explain How does procedural modelling in Houdini 

benefit from using VOP networks? 

Or 

 (b) Explain the role of Houdini’s interface elements in 

facilitating a procedural workflow. 

17.  (a) Explain how does the uses of fog volumes enhance 

the realism of a scene in Houdini.  

Or 

 (b) Describe the steps involved in setting up a fire 

simulations and adding sparks in Houdini. 

18.  (a) How do POP axis and curve forces affect the 

movement and behavior of particles? 

Or 

 (b) Explain the method for rendering particles and the 

significance of the growth attribute setup. 

19.  (a) What are the key considerations when setting up 

basic RBD simulations for realistic destruction 

effects? 

Or 

 (b) How does the Vellum Brush tool contribute to the 

dynamics of cloth simulations in Houdini? 

  

20.  (a) How does adjusting fluid viscosity influence the 

simulation and rendering of liquids in Houdini? 

Or 

 (b)  Describe the process for setting up and rendering a 

complex ocean scene using FLIP fluids. 

———————— 
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 Part A  (10  1 = 10) 

Answer all questions. 

1. __________ feature is used to navigate footage in the 3D 

Equalizer Viewer. 

 (a) Timeline   

 (b) Properties Bin 

 (c) Buer    

 (d) Menu Tab 

2. The benefit of bridging 3D Equalizer with Maya is 

__________      

 (a) To combine tracking data with 3D models 

 (b) To edit sound effects 

 (c) To adjust color grading 

 (d) To increase rendering speed 
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3. The purpose of creating a mesh during tracking is        

__________ 

 (a) To apply textures 

 (b) To define the 3D structure of the tracked object 

 (c) To edit lighting 

 (d) To adjust audio levels 

4. __________ process involves correcting the position of 

tracked points. 

 (a) Error Graph Adjustment 

 (b) Manual Tracking 

 (c) Test Object Tacker 

 (d) Camera Calibration 

5. Clean-up important in rotomation __________        

 (a) To remove unwanted objects 

 (b) To adjust the camera 

 (c) To refine the animation for smooth motion 

 (d) To edit lighting 

6. The purpose of exporting AOVs in rotomation is  

__________    

 (a) To create a final render 

 (b) To provide different passes for compositing 

 (c) To adjust textures 

 (d) To edit sound effects 
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7. The purpose of grading in CG compositing is        

 (a) To create a depth map 

 (b) To adjust the color and contrast of the image 

 (c) To add reflections 

 (d) To edit audio levels 

8. The shadows and reflections are typically added in CG 

compositing __________ 

 (a) Using Fresnel effect 

 (b) By applying textures   

 (c) By adjusting the camera angle    

 (d) Through multi-pass rendering 

9. The purpose of ID Passes in rendering is __________       

 (a) To separate different elements for easier 

compositing 

 (b) To adjust lighting 

 (c) To control camera depth 

 (d) To create particle effects 

10. CG imperfections enhance the realism of a rendered 

image __________        

 (a) By adding unnatural textures 

 (b) By introducing minor flaws like scratches or noise 

 (c) By reducing the quality of the render 

 (d) By increasing color saturation 
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 Part B  (5  5 = 25) 

Answer all questions, choosing either (a) or (b). 

11. (a) Explain the role of matchmoving in integrating CGI 

with live-action footage.  

Or 

 (b) Give an account on the importance of the Menu Tab 

in 3D Equalizer. 

12. (a) Mention the significance of error graphs in manual 

tracking for ensuring tracking accuracy. 

Or 

 (b) Define manual tracking and explain its importance 

in video editing. 

13. (a) Write a short note on the purpose of rotomation in 

the animation pipeline. 

Or 

 (b) Describe the process of setting keys and animating a 

character’s movement in rotomation. 

14. (a) Discuss the use of multi-pass EXR files in CG 

compositing and how they improve the compositing 

process. 

Or 

 (b) Explain how the Fresnel effect contributes to 

realistic reflections in CG compositing. 

15. (a) Explain how Z Depth is used to create depth effects 

in a CG scene. 

Or 

 (b) Discuss the role of atmospheric fog in enhancing the 

depth and realism of CG environments. 
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 Part C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b). 

16. (a) Explain the challenges faced during matchmoving 

in detail. 

Or 

 (b) Describe how to navigate footage using the Viewer 

in 3D Equalizer and its significance in the workflow. 

17. (a) Discuss the challenges and techniques involved in 

manual tracking when handling complex footage. 

Or 

 (b) Explain how creating a mesh helps in tracking and 

why it is crucial for accurate 3D reconstruction. 

18. (a) Describe the clean-up process in rotomation and its 

importance in producing smooth and accurate 

animations. 

Or 

 (b) Explain how geometry tracking is used in 

rotomation to match 3D models to live-action 

footage. 

19. (a) Discuss the importance of grading in CG 

compositing and how it affects the final visual 

output. 

Or 

 (b) Explain the process of shuffling channels in CG 

compositing and how it is used to reconstruct 

images. 
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20. (a) Describe how Normal passes are used in rendering 

and their significance in achieving realistic shading. 

Or 

 (b) Explain the technique of projection in CG and its 

applications in creating realistic environments 

——————— 

 



  

C–6102   

B.Sc. DEGREE EXAMINATION, NOVEMBER 2025. 

Fifth Semester 

Visual Effects 

BUSINESS OF MEDIA 

(2023 onwards) 

Duration : 3 Hours Maximum : 75 Marks 

 Part A  (10  1 = 10) 

Answer all questions. 

1. The business structure that provides flexibility in 

management while offering limited liability to owners  

––––––––––           

 (a) Limited Liability Company 

 (b) Sole Proprietorship 

 (c) General Partnership 

 (d) Cooperative 

2. The type of business organization has limited liability for 

its owners and is considered a separate legal entity is    

––––––––––  

 (a) Partnership  

 (b) Sole Proprietorship 

 (c) Cooperative  

 (d) Corporation 
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3. The organizational structure ideal for media businesses 

that require both specialized expertise and cross-

functional collaboration is –––––––––– 

 (a) Hierarchical structure 

 (b) Matrix structure 

 (c) Divisional structure 

 (d) Functional structure 

4. A media company that has separate divisions for 

newspapers, television, and digital content follows      

–––––––––– organizational structure.  

 (a) Product-based structure 

 (b) Functional structure 

 (c) Geographic structure 

 (d) Hierarchical structure 

5. An example of an internal stakeholder is ––––––––––            

 (a) Customers   

 (b) Local community 

 (c) Employees   

 (d) Suppliers 

6. A sudden change in government trade policies and 

taxation is an example of –––––––––– 

 (a) Social pressure 

 (b) Technological pressure 

 (c) Competitive pressure 

 (d) Political pressure 
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7. –––––––––– strategy aims to place a product in as many 

locations as possible 

 (a) Intensive distribution 

 (b) Exclusive distribution 

 (c) Selective distribution 

 (d)  Limited distribution 

8. ––––––––––  is an example of direct marketing. 

 (a) TV advertisements 

 (b) Social media influencer campaigns 

 (c) Sending promotional emails to customers 

 (d) Newspaper advertisements 

9. The communication method best suited for urgent 

business decisions is –––––––––– 

 (a) Email 

 (b) Face-to-face meetings 

 (c) Social media 

 (d) Printed newsletters 

10. In business communication, the role of active listening is  

–––––––––– 

 (a) To quickly interrupt and share your own opinion 

 (b) To focus on understanding the speaker’s message 

before responding 

 (c) To dominate the conversation 

 (d)  To avoid responding and keep silent 
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 Part B  (5  5 = 25) 

Answer all questions, choosing either (a) or (b). 

11. (a) Discuss the advantages and disadvantages of the 

private sector in business.  

Or 

 (b) Explain the importance of corporate social 

responsibility in private sector businesses. 

12. (a) “Media companies often use a divisional structure”- 

Support your perspective with examples. 

Or 

 (b) Explain how a media company can benefit from a 

geographic organizational structure. 

13. (a) Analyse the impact of technological advancements 

on businesses.  

Or 

 (b) Explain how the interests of shareholders and 

employees may sometimes conflict within an 

organization. 

14. (a) Examine the impact of digital tools and technology 

on modern market research. 

Or 

 (b) Brief on the contribution of international trade to a 

country’s economic growth. 
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15.  (a) Explain the impact of digital communication on 

modern business structures. 

Or 

 (b) Differentiate between verbal and non-verbal 

communication channels with examples. 

 Part C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b). 

16. (a) Compare co-operative societies with other forms of 

business organizations in terms of ownership, 

control, and objectives. 

Or 

 (b) Evaluate the role of leadership and governance in 

the success of not-for-profit businesses. 

17. (a) Discuss how supply chain management differs for 

multinational companies that operate multiple 

product lines in various countries. 

Or 

 (b) Examine the importance of network and team-based 

organizational structures in fostering innovation 

and collaboration. 

18. (a) Explain how do business owners and shareholders 

balance short-term profits with long-term 

sustainability and growth? Provide examples. 

Or 

 (b) Explain how businesses can build trust with 

customers through ethical practices and high-

quality products or services. 
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19. (a) Evaluate the role of capacity planning in operations 

management and analyse how businesses ensure 

optimal resource utilization. 

Or 

 (b) Discuss how global companies adapt their 

marketing mix strategies to different cultural and 

economic markets. 

20. (a) Evaluate the impact of intercultural communication 

on global business operations. 

Or 

 (b) Discuss the role of upward, downward, and 

horizontal communication channels in an 

organization and analyse their contribution to 

business efficiency.  

 

–––––––––– 



  

C–6103   

B.Sc. DEGREE EXAMINATION, NOVEMBER 2025 

Fifth Semester 

Visual Effects 

PORTFOLIO AND PRESENTATION 

(2023 onwards) 

Duration : 3 Hours Maximum : 75 Marks 

 Section A  (10  1 = 10) 

Answer all questions. 

1. The recommended number of slides in a 10-minute 

presentation is  

 (a) 5-7 slides  (b) 15-20 slides 

 (c) 25+ slides  (d) 2 slides 

2. Good body language in a presentation includes       

 (a) Making eye contact and using gestures naturally 

 (b) Standing stiffly without movement 

 (c) Speaking in a monotone voice 

 (d) Looking at the floor while speaking 

3. The file format best suited for documents in a digital 

portfolio is 

 (a) .jpg   (b) .exe 

 (c) .pdf   (d) .mp3 

  

Sub. Code 

82952 
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4. The PowerPoint presentation can be more effective by 

 (a) Use concise bullet points, visuals, and minimal text 

 (b) Fill slides with long paragraphs of text 

 (c) Use small fonts and bright neon colors 

 (d) Avoid using images or graphs 

5. The ideal font size for text on presentation slides is 

 (a) 10-12 Pt for a professional look 

 (b) 18-24 pt for visibility 

 (c) 8-10 Pt to fit more content 

 (d) 14-16 Pt for detailed paragraphs 

6. The file format that ensures high-quality images without 

large file sizes is 

 (a) .bmp   (b) .png 

 (c) .gif   (d) .tiff 

7. SEO in digital marketing stand for             

 (a) Sales and Engagement Optimization 

 (b) Search Engine Optimization 

 (c) Social E-commerce Outreach 

 (d) Systematic Email Outreach 
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8. The purpose of customer relationship management in 

marketing is           

 (a) To improve customer interactions and retention 

 (b) To decrease advertising expenses 

 (c) To eliminate competitors 

 (d) To create new products 

9. It is important to track portfolio performance metrics           

 (a) To determine how much storage space is needed 

 (b) To count how many projects have been uploaded 

 (c) To understand visitor engagement and optimize 

content 

 (d) To ensure compliance with copyright laws 

10. The main risk of failing to plan deadlines properly is          

 (a) Delays that may affect job opportunities or client 

trust 

 (b) Saving time by rushing work 

 (c) Getting extra time for revisions 

 (d) Creating multiple versions without focus 

 Section B  (5  5 = 25) 

Answer all the questions, choosing either (a) or (b) 

11. (a) List and describe five key components of a 

professional portfolio. 

Or 

 (b) Describe the role of a personal statement or bio in a 

portfolio. 
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12. (a) Describe the role of pre-production, production, and 

post-production in digital media creation with 

provide examples. 

Or 

 (b) Compare the design processes of a website and a 

multimedia presentation. 

13. (a) Discuss the advantages and disadvantages of using 

PowerPoint versus Prezi for presentations. 

Or 

 (b) Explain the role of software tools in creating and 

enhancing a presentation. 

14. (a) Explain the importance of material selection in the 

impact and perception of a business card. 

Or 

 (b) Discuss how businesses use blogs and webpages 

together to create a strong online presence and drive 

sales. 

15. (a) Discuss the advantages and disadvantages of 

publishing a portfolio online versus in print. 

Or 

 (b) Brief on how updating and curating content 

regularly contribute to portfolio enhancement. 



C–6103 

  

  
5 

 Section C  (5  8 = 40) 

Answer all questions, choosing either (a) or (b) 

16.  (a) “Personalization and storytelling make a portfolio 

more appealing”- Justify with explanation. 

Or 

 (b) Compare and contrast a working portfolio and a 

display portfolio. 

17. (a) Analyze the role of user experience in digital 

portfolios and steps to ensure easy navigation and 

accessibility. 

Or 

 (b) How does post-production affect the quality of 

digital media? Discuss the key elements. 

18. (a) How do visual aids enhance professional 

presentation? Discuss on the best practices. 

Or 

 (b) Discuss the essential technical and non-technical 

requirements for a professional presentation. 

19. (a) Evaluate the role of cultural and industry-specific 

considerations in designing business cards. 

Or 

 (b) How does competitor analysis help businesses 

decide which marketing medium to use? Provide 

examples. 
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20. (a) Describe the essential components of a strong 

portfolio and explain how each component 

contributes to creating a professional and impactful 

presentation. 

Or 

 (b) “Budget and deadline planning essential in portfolio 

development”- Discuss strategies for managing costs 

and meeting deadlines effectively. 

 

——————— 

 


